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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking on an enterprise solution consisting of Avaya IP Office 10.1 to support
Frontier Communications SIP Trunking Service.

The test was performed to verify SIP trunk features including basic calls, call forward (all
calls, busy, no answer), call transfer (blind and consult), conference, and voice mail. The calls
were placed to and from the public switched telephone network (PSTN) with various Avaya
endpoints.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the steps necessary for configuring Session Initiation Protocol
(SIP) Trunking service between Frontier Communications and an Avaya SIP-enabled enterprise
solution.

In the configuration used during the testing, the Avaya SIP-enabled enterprise solution consists
of Avaya IP Office 500 V2 Release 10.1 (hereafter referred to as IP Office) and various Avaya
endpoints, listed in Section 4.

The Frontier Communications SIP Trunking Service referenced within these Application Notes
is designed for business customers. Customers using this service with the IP Office solution are
able to place and receive PSTN calls via a broadband wide area network (WAN) connection
using the SIP protocol. This converged network solution is an alternative to traditional PSTN
trunks such as analog and/or ISDN-PRI trunks. This approach generally results in lower cost for
the enterprise.

The terms “service provider”, “Frontier Communications” or “Frontier” will be used
interchangeably throughout these Application Notes.

2. General Test Approach and Test Results

The general test approach was to connect a simulated enterprise site to Frontier’s network via the
public Internet, as depicted in Figure 1, and exercise the features and functionalities listed in
Section 2.1.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.

2.1. Interoperability Compliance Testing

To verify SIP trunk interoperability the following features and functionalities were exercised
during the interoperability compliance test:

e Response to SIP OPTIONS queries.

e Incoming PSTN calls to various Avaya endpoints, including SIP, H.323, digital, and
analog endpoints at the enterprise. All incoming calls from the PSTN were routed to the
enterprise across the SIP trunk from the service provider network.

e QOutgoing PSTN calls from Avaya endpoints, including SIP, H.323, digital, and analog
endpoints at the enterprise. All outgoing calls to the PSTN were routed from the
enterprise across the SIP trunk to the service provider network.

e Incoming and outgoing PSTN calls to/from Avaya Communicator for Windows.

¢ Incoming and outgoing PSTN calls to/from Avaya Communicator for Web.
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Dialing plans including local calls, outbound toll-free, etc.

Caller ID presentation.

Proper disconnect when the caller abandons the call before the call is answered.

Proper disconnect via normal call termination by the caller or the called parties.

e Proper disconnect by the network for calls that are not answered (with coverage to
voicemail off).

e Proper response to busy endpoints.

e Proper response/error treatment when dialing invalid PSTN numbers.

e Proper codec negotiation and two way speech-path. Testing was performed with codecs:
G.711MU and G.729A, Frontier’s preferred codec order.

e Proper response to no matching codecs.

e T.38 and G711 pass-through fax.

e Proper early media transmissions.

Voicemail and DTMF tone support using RFC 2833 (leaving and retrieving voice mail

messages, etc.).

Outbound Toll-Free calls, interacting with IVR (Interactive Voice Response systems).

Call Hold/Resume (long and short duration).

Call Forward (unconditional, busy, no answer).

Blind Call Transfers.

Consultative Call Transfers.

Station Conference.

Mobility twinning of incoming calls to mobile phones.

Items not supported or not tested included the following:
e The SIP REFER method for call redirection is not fully supported by Frontier, therefore it
was not tested.
e Inbound toll free calls was not tested.
e 0,0+10digits, 411 Directory Assistance, 911 Emergency and international calls are
supported by Frontier but were not tested.
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2.2. Test Results

Interoperability testing of Frontier Communications SIP Trunking Service was completed with
successful results for all test cases with the exception of the observations/limitations described

below.
[ )

T.38 Fax: Frontier does not support the method in which IP Office negotiates the use of
T.38 for fax, which consist of IP Office sending a re-INVITE message with two media
lines in the SDP, with the first media line set for audio, with the port set to 0, and the
second media line set for T.38, with a valid port number, thus de-activating audio
transmission for the call. To solve this issue, a SIP Line Custom String (SLIC) was added
to the IP Office configuration used during the testing, as shown in Section 5.3.8. With the
configuration shown in Section 5.3.8, IP Office will reverse the order of media line
entries in the SDP, so that the active T.38 media line entry appears first, followed by the
inactive audio media line entry, with the port set to 0. Although the re-INVITE message to
use T.38 for fax was recognize by Frontier after this change was made, at the time of the
testing, Frontier responded to the re-INVITE message sent by Avaya IP Office with "488 Not
Acceptable Here", this resulted in the fax defaulting to G.711 pass-through. IP Office was
configured to use T.38 on the first attempt, and G.711 pass-through if T.38 failed (refer to
Section 5.3.5). G.711 pass-through fax was successfully tested in both directions.

Incorrect Call Display on call transfers to the PSTN Phone: Call display was not properly
updated on PSTN phone involved in a call transfer. After the call transfer was completed to
the PSTN, the PSTN phone did not display the actual connected party, instead the DID
number assigned to the IP Office station that initiated the transfer was displayed.

Outbound call from an enterprise extension to a busy PSTN number: Frontier
Communications did not send a “486 Busy Here” message on an outbound call to a
PSTN number that was busy, as expected. There was no direct impact to the user, who
heard busy tone.

2.3. Support

For support on Frontier Communications systems visit the corporate Web page at:
https://frontier.com/enterprise

Avaya customers may obtain documentation and support for Avaya products by visiting
http://support.avaya.com. Alternatively, in the United States, (866) GO-AVAYA (866-462-8292)

provides access to overall sales and service support menus.
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3. Reference Configuration

Figure 1 illustrates the test configuration used for the DevConnect compliance testing. The test
configuration simulates an enterprise site with an Avaya SIP-enabled enterprise solution
connected to the Frontier Communications SIP Trunking Service through the public Internet.

The Avaya components used to create the simulated enterprise customer site includes:
e Avaya IP Office 500 V2.
= Avaya IP Office Application Server running Avaya Voicemail Pro, Avaya one-X® Portal
for IP Office and Avaya WebRTC Gateway.
Avaya 96x1 Series H.323 IP Deskphones.
Avaya 1100 Series SIP IP Deskphones.
Avaya 9508 Digital Deskphones.
Analog Deskphones.
Avaya Communicator for Windows softphone.
Avaya Communicator for Web softphone.

The enterprise site contains the Avaya IP Office 500 V2 with analog and digital extension
expansion modules, as well as a VCM®64 (Voice Compression Module) for supporting VolP
codecs. The LANL1 port of Avaya IP Office is connected to the enterprise LAN (private network)
while the LANZ port is connected to the public network. Endpoints include Avaya 96x1 Series
IP Deskphones (with H.323 firmware), Avaya 1100 IP Deskphones (with SIP firmware), 9508
Digital Deskphones, Analog Deskphones, Avaya Communicator for Windows and Avaya
Communicator for Web. The site also included an Avaya IP Office Application Server running
Avaya Voicemail Pro (providing voice messaging service to the IP Office users), Avaya one-X®
Portal for IP Office and Avaya WebRTC Gateway. Mobile Twinning is configured for some of
the IP Office users so that calls to these user’s extensions will also ring and can be answered at
the configured mobile phones.

Avaya recommends our customers implement Avaya solutions using appropriate security and
encryption capabilities enabled by our products. The testing referenced in this DevConnect
Application Note included the enablement of supported encryption capabilities in the Avaya
products. Readers should consult the appropriate Avaya product documentation for further
information regarding security and encryption capabilities supported by those Avaya products.

Support for these security and encryption capabilities in any non-Avaya solution component is
the responsibility of each individual vendor. Readers should consult the appropriate vendor-
supplied product documentation for more information regarding those products.

For the testing associated with this Application Note, the interface between the Avaya system
and the Frontier Communications network did not include the use of any specific encryption
features.

The transport protocol between IP Office and Frontier Communications, across the public
Internet, is SIP over UDP. The transport protocol between Avaya SIP endpoints and IP Office,
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inside the enterprise private IP network (LAN), was SIP over TLS. H.323 endpoints were
configured to use TLS signaling inside the enterprise private IP network (LAN) if supported by
the H.323 endpoint.

For the purposes of the compliance test, users dialed a short code of 9 + N digits to make calls
across the SIP trunk to Frontier Communications. The short code 9 was stripped off by IP Office
but the remaining N digits were sent unaltered to the network. Refer to Section 5.5 for
configuration.

In an actual customer configuration, the enterprise site may include additional network
components between the service provider and the IP Office system, such as a session border
controller or data firewall. A complete discussion of the configuration of these devices is beyond
the scope of these Application Notes. However, it should be noted that all SIP and RTP traffic
between the service provider and the IP Office system must be allowed to pass through these
devices.

For confidentiality and privacy purposes, public IP addresses, domain names, and routable DID
numbers used during the compliance testing have been masked.
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Deskphones

Fax

LAN2: 10.10.80.52

LAN1: 10.64.70.60
Avaya IP Office 500 V2.

10.64.101.246

Rel 10.1

Avaya IP Office Application
Server:

- Avaya Voicemail Pro

- Avaya WebRTC Gateway
- Avaya one-X® Portal

. e )
Simulated Enterprise
Domain: avaya.lab.com
DIDs: 5851239827 to 9829

- |P Office Manager
- Avaya Communicator for Avaya 96x1 Series Avaya 1100 Series IP
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Figure 1: Avaya Interoperability Test Lab Configuration
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4. Equipment and Software Validated

The following equipment and software were used for the sample configuration provided:

Equipment/Software

Release/Version

Avaya

Avaya IP Office 500v2

10.1.0.1.0 Build 3

Avaya IP Office DIG DCPx16 V2

10.1.0.1.0 Build 3

Avaya IP Office Manager

10.1.0.1.0 Build 3

Avaya IP Office Application Server
= Voicemail Pro
= Avaya WebRTC Gateway
= Avaya one-X® Portal for IP Office

10.1.0.1.0 Build 3
10.1.0.1.0 build 6
10.1.0.1.0 build 3
10.1.0.1.0 build 3

Avaya 96x1 Series IP Deskphones (H.323)

Version 6.6506

Avaya 1140E IP Deskphones (SIP)

SIP1140e Ver. 04.04.23.00

Avaya 9508 Digital Telephone 0.60

Analog Deskphones N/A

Avaya Communicator for Windows 2.1.4.274

Avaya Communicator for Web 1.0.18.1124
Frontier Communications

Metaswitch cCFS (Clustered Call Feature 9.3.20

Server)

Oracle 3820 Session Border Controller 6.4

Note: Compliance Testing is applicable when the tested solution is deployed with a standalone
IP Office 500 V2 and also when deployed with all configurations of IP Office Server Edition.
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5. Configure Avaya IP Office

This section describes the IP Office configuration required to interwork with Frontier
Communications SIP Trunking Service. IP Office is configured through Avaya IP Office
Manager (IP Office Manager) which is a PC application. On the PC, select Start = Programs
- IP Office - Manager to launch IP Office Manager. Navigate to File = Open
Configuration, select the proper IP Office from the pop-up window, and log in with the
appropriate credentials. A management window will appear as shown in the next sections. The
appearance of IP Office Manager can be customized using the View menu (not shown). In the
screenshots presented in this section, the View menu was configured to show the Navigation
pane on the left side and the Details pane on the right side. These panes will be referenced
throughout these Application Notes.

These Application Notes assume the basic installation and configuration of IP Office have
already been completed and are not discussed here. For further information on IP Office, please
consult Error! Reference source not found. in Section 9.

5.1. Licensing and Physical Hardware

The configuration and features described in these Application Notes require the IP Office system
to be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity,
contact an authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity; click License, then
from the license tab, locate SIP Trunk Channels. Confirm that there is a valid license with
sufficient “Instances” (trunk channels) in the Details pane.

IP Offices !
=R BOOTP (6) License | Remote Server
i Oi erator |3 - ]
-5 License Mode License Normal

I :[‘7: Eﬁie(;ns]m Licensed Version  10.0

(-2 Control Unit (4) PLDS Host ID

[« Extension (48) ] )

B a User (50) PLDS File Status ~ Valid

(-4 Group (1)

E s ghort Code (69) Feature Key Instances Status Expiration Date Source

ol R:zlée) o Software Upgrade 8 (R9.1) s@KWbMyld... 1 Obsolete Never ADINodal

[ @ Incoming Call Route (3) Essential Edition fludo0hStKO... 255 Obsolete Mewver ADI Nodal

i WAN Port (0) Receptionist N/A 4 Valid Never PLDS Nodal
o $|i:::t§:§ff?ej o Additional Voicemail Pro Ports N/A 152 Valid Never PLDS Nodal
- ) VMPro Recordings Administrators ~ N/A 1 Valid Newver PLDS Nodal

(- Firewall Profile (1) e - ;

- [l IP Route (7) Essential Edition Additional Voice.. N/A 4 Valid Never PLDS Nodal
- Account Code (0) VMPro TTS (Generic) N/A 40 Valid Newver PLDS Nodal
Teleworker N/A 384 Valid Never PLDS Nodal
-~ Tunnel () Mobile Worker N/A 384 Valid Never PLDS Nodal

i 5(' hod é‘)ght‘ ® Office Worker N/A 384 Valid Never PLDS Nodal
&8 Location (0) MAvaya Softphone Licence N/A 100 Valid Mewver PLDS Nodal
5% Authorization Code (0) VMPro TTS (Scansoft) NFA 40 Valid Never PLDS Nodal

VMPro TTS Professional NFA 40 Valid Never PLDS Nodal
IPSec Tunnelling N/A 1 Valid Newver PLDS Nodal
Power User NFA 384 Valid MNever PLDS Nodal
Avaya IP endpoints NFA 384 Valid Never PLDS Nodal
IP500 Voice Networking Channels  N/A 32 Valid Never PLDS Nodal
SIP Trunk Channels LS |128 | valid | Never | PLDS Nodal
IP500 Universal PRI (Additional cha... M/A 100 Valid MNewver PLDS Nodal
CTI Link Pro N/A 1 Valid Never PLDS Nodal
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To view the physical hardware comprising IP Office, expand the components under the Control
Unit in the Navigation pane. In the sample configuration, the Avaya IP Office 500 V2 is
equipped with analog and digital extension expansion modules, as well as a VCM64 (Voice
Compression Module) for supporting VolP codecs. An IP Office hardware configuration with a
VVCM component is necessary to support SIP trunking.

To view the details of the component, select the component in the Navigation pane. The
following screen shows the details of the IP 500 V2.

IP Offices = IP 500 V2
=R BOOTP (&) Unit
-¢# Operator (3
-2 [1P500V2 Main Device Number .
---L-“,.-' System (1] )
f-F7 Line (25) Unit Type 1P 500 V2
== Control Unit (4 :
e 1]]’5[.'!] Version 10.1.01.0 build 3
jgﬁgﬁ;ﬁ Serial Number
iy 6 DIG DCPxE V2 _
10.64.70.60
- Extension (48) Unit [P Address
@ User (50) Interconnect Number 0
[-4@ Group (1)
&-8% Short Code (69) Module Number Control Unit
----- @ Service (0)
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5.2. System

Configure the necessary system settings. In an IP Office the LANZ2 tab settings correspond to the
IP Office WAN port (public network side) and the LAN1 tab settings correspond to the LAN

port (private network side).

5.2.1. System — LAN2 Tab

In the sample configuration, the IP Office WAN port was used to connect to Frontier
Communications. The LAN2 settings correspond to the WAN port on the IP Office 500 V2. To
access the LAN2 settings, first navigate to System - <Name>, where <Name> is the system
name assigned to IP Office. In this compliance test, the system name is IP500V2 Main. Next,
navigate to the LAN2 - LAN Settings tab in the Details pane, configure the following

parameters:

e Setthe IP Address field to the public IP address assigned to the IP Office WAN port.

e Set the IP Mask field to the mask used with the public IP address. All other
parameters should be set to default or according to customer requirements.

e Click OK to commit (not shown).

IP Offices

B
-
o

IP500V2 Main

=& BOOTP (6)
-{% Operator (3)
E|""'j:.J IP500V2 Main
El{=2 System (1)

| System | LANL I LAMNZ |DNS | Voicemail | Telephony | Directory Services | System Events | SMTP

LAN Settings | yolP | Network Topology|

-5 IPS00V2 Main IP Address 32
77 Line (25)
i< Control Unit (4) IP Mask 0
-4 Extension (48) )
E:I"'a User (50) Prirary Trans, IP Address 0
-3 Group (1) Firewall Profile [<None> v]
(8% Short Code (69)
""" B Senvice ) RIP Mode [None - |
F-all; RAS (1)
@) Incoming Call Route (3) [C] Enable NAT
----- §8 WAN Port (0) B
,,,,, =5 Directory (0) Number Of DHCP IP Addresses
""" €171 Time Profile (0) DHCP Mode
(@8 Firewall Profile (1) ] ] ) )
=-J§ll IP Route (7) () Server () Client () Dialln @ Disabled Advanced
----- Bl Account Code (0)
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On the VVoIP tab in the Details pane, configure the following parameters:
e Check the SIP Trunks Enable to enable the configuration of SIP Trunk connecting to
Frontier Communications.

e Verify the RTP Port Number Range settings for a specific range for the RTP traffic.
The Minimum and Maximum values were kept as default.

IP Offices

| x

= IP500V2 Main

R BOOTP (6)

[#-¢% Operator (3]

=145 IP500V2 Main

550 Systemn (1)
4553 [P5S00V2 Main

111 Line (25)

t-<2% Control Unit (4)

t-4 Extension (48)

H-§  User (50)

Jﬂ Group (1)

H-B% Short Code (69)

@ Service (0)

oy RAS (1)

m

-8 WAN Port (0)
Directory (0}
2! Time Profile (0)

- Firewall Profile (1)
ol IP Route (7)
-l Account Code (0)
%y License (90)

- Tunnel (0)
J---a-; User Rights (8)
H-"g ARS (2)
- Location (0)

Je Incoming Call Route (3)

m Authorization Code (0)

[ System [ LNt | LAN2 | DNS | Voicemail | Telephony | Directory Senvices | System Events | SMTP | SMDR [veM [ volP | ValP Security

| LAN Settingsl VolP |Network Topology|

[] H323 Gatekeeper Enable

H.323 Signaling over TLS Disabled

SIP Trunks Enable

[T] SIP Registrar Enable
Auto-create Extension/User

sil.miami.avaya.com

sil.miami.avaya.com

upp UDP Port {5060
TCP TCP Port  |5060
TLS TLS Port 9061
T 10
RTP
Port Mumber Range
Minimurm 48152 s Maximum 53246 =
Port Mumber Range (MAT)
Minimum 49152 = Maximum 53246 =

Auto-create Extension Auto-create User H.323 Remote Extension Enable

Port |5060

Port [5061

t (1720

SIP Remote Extension Enable

t 5060
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Scroll down the page:

e Inthe Keepalives section, set the Scope to RTP-RTCP. Set the Periodic timeout to 30
and the Initial keepalives parameter to Enabled. These settings will cause IP Office to
send a RTP and RTCP keepalive packet starting at the time of initial connection and
every 30 seconds thereafter if no other RTP/RTCP traffic is present. This facilitates the
flow of media in cases where each end of the connection is waiting to see media from the
other, as well as helping to keep firewall ports open for the duration of the call.

e Inthe DiffServ Settings section, IP Office can also be configured to mark the
Differentiated Services Code Point (DSCP) in the IP Header with specific values to
support Quality of Services policies for both signaling and media. The DSCP field is the
value used for media and the SIG DSCP is the value used for signaling. The specific
values used for the compliance test are shown in the example below and are also the
default values. For a customer installation, if the default values are not sufficient,
appropriate values will be provided by the customer.

e All other parameters should be set to default or according to customer requirements.

e Click OK to commit (not shown).

IP Offices = IP500V2 Main

': ggg;fofﬁé] | System [ LANL | LAN2 | DNS | Voicemail | Telephony | Directory Services | System Events | sMTP | sMDR [vem [ vor |
-2 [1P500V2 Main | LAN Settings | VoIP [ Network Topology |

=t = System (1) RTP

-2 IP500V2 Main

&1 Line (25) Port Mumber Range

E-<=r Control Unit (1) Minimum 49152 & Maximum 53246 <

-4 Extension (48)

g% E:SLS?E] Port Mumber Range (MAT)

(-8 Short Code (69) Minimum 49152 = Maxirmum 53246 =

----- @ Service (0)

o RAS (1) Lo

EJ---% Incoming Call Route () Enable RTCP Monitoring on Port 5005

""" @ WAN Port (0) RTCP collector IP address for phones 0 0 0 0

..... “ Directory (0) Keepalives

{7 Time Profile (0) P

(-8 Firewall Profile (1) Scope ’RTP—RTCP VI Periodic timeout 30
(-Jill IP Route (7)

..... #m Account Code (0) Initial keepalives ’Enabled ']

----- & License (90)

""" @& Tunnel (0)

[-fig User Rights ()

- ARS (2) iffServ Settings

""" & Location (0) DiffServ Setting

----- &% Authorization Code (0} B3 7| DSCP(Hex) B3 +| Video DSCP (Hex) |FC 7| DSCP Mask (Hex) 88 T SIG DSCP (Hex)
46 +| DscP 46 +| Video DSCP 63 1| DSCP Mask 34 +| SIGDSCP

Note: In the compliance test, the LAN1 interface was used to connect the Avaya IP Office to the
enterprise site IP network (private network). The LANL1 interface configuration is not directly
relevant to the interface with the Frontier Communications SIP Trunking Service, and therefore
is not described in these Application Notes.
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5.2.2. System - Telephony Tab
To access the System Telephony settings, navigate to the Telephony - Telephony tab in
the Details pane, configure the following parameters:

e Choose the Companding Law typical for the enterprise location, U-Law was used
for the compliance test, A-Law could have been selected instead.

e Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding
and call transfer to the PSTN. If for security reasons incoming calls should not be
allowed to transfer back to the PSTN then leave this setting checked.

e All other parameters should be set to default or according to customer requirements.

e Click OK to commit (not shown).

o Firewall Profile (1)
+- il IP Route (7)
-l Account Code (0)
- License (90)

Tunnel (0}
+-5 User Rights (8)
H-“f¢ ARS (2)

&g Location (0)

a Authorization Code (0)

IP Offices | E IP500V2 Main
=-R EJOOTS (5]3 System [ LANL |LAN2 | DNS [ Voicemail | Telephony | Directory Services | System Events | SMTP [ SMDR [veM | volp | volP Security
erator
5002 Main Telephony | Park&Pagel Tones & Muswcl Ring Tones | 5M | Call Log | TUI |
7 System (1)
%7 IP500V2 Main Analogue Extensions Companding Law
5T Line (25) Switch Line
t-<2% Control Unit (4) Default Qutside Call Sequence [Normal v]
t-4f Extension (48) _ _ .
H-§  User (50) Default Inside Call Sequence [Rlng Typel v] @ U-Law @ U-Law Line
H-ayl Grou
32 Shnrtpctﬂie(ﬁg) Default Ring Back Sequence [Ring Type2 v]

- @ AL @ A-LawLi
4B Service (0) Restrict Analogue Extension Ringer Voltage [ - w - awkine
-l RAS (1)

J@ Incoming Call Route (3)

iji gAtponmﬁl Dial Delay Time (sec) 4 O pss status
irectory

El“ Time Profile (0) Dial Delay Count 0 Auto Hold

. Dial By Name
Default No Answer Time (sec) 15

Show Account Code

OaRIOE OO REERER

Hold Timeout (sec) 0
| [ Inhibit OFf-Switch Forward/Transfer

Park Timeout (sec) 300

[] Restrict Metwork Interconnect
Ring Delay (sec) 5

Include location specific information

Call Priority Promotion Time (sec) |Disabled 5

[C] Drop External Only Impromptu Conference
Default Currency usp hd

[] Visually Differentiate External Call
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5.2.3. System - VoIP Tab

To view or change the System Codecs settings, navigate to the VolP tab in the Details pane as
shown in the following screen, configure the following parameters:
e The RFC2833 Default Payload field allows for the manual configuration of the payload
type used on SIP calls that are initiated by the IP Office. The default value 101 was used.
e For codec selection, select the codecs and codec order of preference on the right, under
the Selected column. The Default Codec Selection area enables the codec preference
order to be configured on a system-wide basis. The buttons between the two lists can be
used to move codecs between the Unused and Selected lists, and to change the order of
the codecs in the Selected codecs list. By default, all IP lines and phones (SIP and H.323)
will use the system default codec selection shown here, unless configured otherwise for a
specific line or extension. The example below shows the codecs used for IP phones (SIP
and H.323), the system’s default codecs and order was used.
e Click OK to commit (not shown).

IP Offices = IP500V2 Main
@& BOOTP (6) [ system | LANL [ LaNz [ DNS [ Voicemail | Telephony | Directory Services | System Events [ smTP | sMDR [vem | voP |

¢+ Operator (3)

=) IP500V2 Main Ignore DTMF Mismatch For Phones 0

= Systemn (1) . . . .
{5 IP500V2 Main Allow Direct Media Within NAT Location [

-1 Line (25)

B2 Control Unit (4) |RFC2833 Default Payload 101 = |

-4 Extension (48)

E]---i User (50) MAvailable Codecs Default Codec Selection

EJ"'@ Group (1) Unused Selected

E?:g o G711 ULAW 64K 672264 s> || [6711 uaweak
o RAS (1) G711 ALAW 64K G711 ALAW 64K
- Incoming Call Route (3) 6.722 64K G.729(z) 8K CS-ACELP

..... £ WAN Port (0) G.729(a) 8K CS-ACELP 67231 6K3 MP-MLQ

_____ o Directory (0) G6.723.1 6K3 MP-MLQ s

£ Time Profile (0)
(-8} Firewall Profile (1)
=-Jill IP Route (7)

----- 8 Account Code (0) s

----- %= License (90)

Note: The codec selections defined under this section (System — VolP Tab) are the codecs
selected for the IP phones/extensions. The codec selections defined under Section 5.3.5 (SIP
Line — VVoIP tab) are the codecs selected for the SIP Line (Trunk).
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5.2.4. IP Route

Create an IP route to specify the IP address of the gateway or router where the IP Office needs to
send the packets in order to route calls to Frontier Communications network.

Navigate to IP Route, right-click on IP Route and select New. The values used during the
compliance test are shown below:
e Set the IP Address and IP Mask to 0.0.0.0 to make this the default route.

e Set Gateway IP Address to the IP address of the gateway/router used to route calls to the
public network, e.g., 10.10.80.1.

e Set Destination to LAN2 from the pull-down menu.
e Click OK to commit (not shown).

IP Offices |E3 0.0.0.0°
=& BOOTP (6) IP Route
(7 Operator (3)
g4 IP Address 0 0 0 0
EI---’-_:.J System (1)
i3y IPS00V2 Main IP Mask 0o .0 .0 .0
BT Line (29) Gateway IP Address 0 . 10 . 80 1
(-2 Control Unit (4)
-4 Extension (48) Drestination ’LANZ
G-§  User (50)
[}..Q Group (1) Metric 0
(-8 Short Code (69)
_____ @ Service (0) ] Proxy ARP
- ol RAS (1)
(- @ Incoming Call Route (3)
----- ¥2 WAN Port (0)
----- a1 Directory (0)
----- 17 Time Profile (0)
10,64.101.0
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5.3. SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and Frontier
Communications. The recommended method for configuring a SIP Line is to use the template
associated with these Application Notes. The template is an .xml file that can be used by IP
Office Manager to create a SIP Line. Follow the steps in Section 5.3.1 to create the SIP Line
from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses

e SIP Credentials (if applicable)

e SIP URI entries

e Setting of the Use Network Topology Info field on the Transport tab

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary
after the SIP Line is created via the template. The resulting SIP Line data can be verified against
the manual configuration shown in Sections 5.3.2 to 5.3.8.

Alternatively, a SIP Line can be created manually. To do so, right-click on Line in the
Navigation pane and select New => SIP Line. Then, follow the steps outlined in Sections 5.3.2
t0 5.3.8.

5.3.1. Creating a SIP Trunk from an XML Template

DevConnect generated SIP Line templates are always exported in an XML format. These XML
templates do not include sensitive customer specific information and are therefore suitable for
distribution. The XML format templates can be used to create SIP trunks on both IP Office
Standard Edition (500 V2) and IP Office Server Edition systems. Alternatively, binary templates
may be generated. However, binary templates include all the configuration parameters of the
Trunk, including sensitive customer specific information. Therefore, binary templates should
only be used for cloning trunks within a specific customer’s environment.

Copy a previously created template file to a location (e.g., \temp) on the same computer where IP
Office Manager is installed.
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To create the SIP Trunk from the template, right-click on Line in the Navigation Pane, then
navigate to New from Template->Open from file.

- & BOOTP (6) SIP Line |Transport |SIP URI|VelP  [T38 Fax|SIP Credentials
[+-¢# Operator (3
EI'"’“_“ IPS00VZ Main Line Nurnher 17 =
& Sy
o 0 New d clearcom.mx
=R | Lit
1:_,.- & Cut Ctrl+X
..... ~ 23 Co Ctrl+C
..... ~ i E:
_____ ~ o Paste Ctrl+V
..... wy| 7 Delete Ctrl+Del ’Cl':‘“d
----- ™ ./ Validate
..... Ny Connect To... Ctrl+T
..... y
..... y Mew from Template J Open from file
""" ? Export as Termplate 0
----- 14 203 1l -
HG; Reviewed: Solution & Interoperability Test Lab Application Notes 18 of 40

SPOC 4/10/2018 ©2018 Avaya Inc. All Rights Reserved. FrontierlPO101



Navigate to the directory on the local machine where the template was copied and select the
template.

7 Open ==

@uv| 4 v Computer » TOSHIBA (F:) » Frontier Communications » App.Motes » IPO101 (no ASBCE) » Template - |¢f|| Search Template Pl

Organize + New folder =~ [ '@'

Name Date modified Type Size

-

) Libraries
3 Documents
,J’. Music
= Pictures

BE videos

| =] FrontierdPO101.xml 3/14/2018 10:03 AM XML Document 4KE |

m

1% Computer
&, Avaya €SOE (C)
= TOSHIBA ()
= TOSHIBA (F:)

File name: - [Template Files (*.xml) V]l

[ open | [ concel |

After the import is complete, a final import status pop-up window will open stating success or
failure. Click OK.

P )

Template Provisioning @

[0] Mew SIP Trunk created successfully using selected template.

The newly created SIP Line will appear in the Navigation pane (e.g., SIP Line 17).

=K BOOTP (6)
4% Operator (3

=-+={ IP500V2 Main

EI“""T::‘ Systemn (1]
L) TPS00V2 Main
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It is important that the SIP Line configuration be reviewed and updated if necessary after the SIP
Line is created via the template. The resulting SIP Line data can be verified against the manual
configuration shown in Sections 5.3.2 to 5.3.8.

5.3.2. SIP Line — SIP Line Tab
On the SIP Line tab in the Details pane, configure or verify the parameters as shown below:

e Leave the ITSP Domain Name blank, when empty, the default host is provided by the
SIP Line | SIP Transport | ITSP Proxy Address field value.
e Setthe Local Domain Name to the public IP address assigned to the IP Office LAN2
interface. Refer to Section 5.2.1.
e Verify that In Service box is checked, the default value. This makes the trunk available
to incoming and outgoing calls.
e Verify that Check OOS box is checked, the default value. IP Office will use the SIP
OPTIONS method to periodically check the SIP Line.
e Verify that Refresh Method is set to Auto.
e Verify that Timer (sec) is set to On Demand.
e For the compliance test REFER support was disabled. Thus, Incoming Supervised
REFER and Outgoing Supervised Refer should be set to Never. Refer to Section 2.1.
e Click OK to commit (not shown).
IP Offices |EE SIP Line - Line 17
::: ggr:o(rﬁé] SIP Line [Transport|SIP URI|VolP [ 38 Fax|SIP Credentials| SIP Advanced|Engineering
B ’_ Line Number 17 z In Service
[#-%53 System (1)
é---T— ITSP Domain Name Check 008
: é Local Domain Name 10.10.80.52
: URI Type s ~| [ Session Timers
:::: ég Location [Cloud «| | Refresh Method Auto
----- 21 Timer (sec) On Demand
N
120 Prefix
PRk National Prefx 0
:;j o Intemational Prefix 00
-7 206 Country Code Redirect and Transfer
E ;g; Name Priority System Default 7] | Incoming Supervised REFER [Never
E 523 Description Service Provider Outgoing Supervised REFER [ Never
et Send 302 Moved Temporarily  [C]
:;j 2 Outgoing Blind REFER B
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5.3.3. SIP Line - Transport Tab

Select the Transport tab. Set or verify the parameters as shown below:
e Setthe ITSP Proxy Address to the SIP Proxy IP address provided by Frontier. Refer to

Figure 1.
Set Layer 4 Protocol to UDP.

Set the Send Port and Listening Port to 5060.
Default values may be used for all other parameters.
Click OK to commit (not shown).

Set Use Network Topology Info to None (refer to the note below).

E Avaya IP Office Manager IP500%2 Main [10.1.0.1.0 build 3] [Administrator(Administrator)]
File Edit View Tools Help

25-d DA v s2°8

)

IP Offices 1E

SIP Line - Line 17

=-#& BOOTP ()

'SIP Line| Transport{sip URI| VolP |38 Fax|SIP Credentials|SIP Advanced|Engineering

E.

t-{#% Operator (3]
5= 50002 Mair]
;-"*-w Systern (1)

ITSP Proxy Address 192.168.24.40

e

Metwork Configuration

""" a2 Layer 4 Protocol ’UDP

vl Send Port 5060

----- ;18 Use MNetwork Topology Info ’None

vl Listen Port 5060

""" ™ 20 Explicit DNS Server(s) 0 0 0

..... "y, 22 Calls Route via Registrar

Separate Registrar

0 0 0 0

Note — For the compliance testing, the Use Network Topology Info field was set to None,
since no NAT was used in the test configuration. In addition, it was not necessary to configure
the System = LAN2 > Network Topology tab for the purposes of SIP trunking. If a NAT is
used between Avaya IP Office and the other end of the trunk, then the Use Network Topology
Info field should be set to the LAN interface (LAN1 or LAN2) used by the trunk and the
System = LANL1 (or 2) = Network Topology tab needs to be configured with the details of

the NAT device.
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5.3.4. SIP Line - SIP URI Tab

A SIP URI entry needs to be created to match each incoming number that IP Office will accept
on this line. Select the SIP URI tab, and then click the Add... button and the New Channel area
will appear at the bottom of the pane. To edit an existing entry, click an entry in the list at the
top, and click the Edit... button. In the example screen below, a previously configured entry was
edited. For the compliance test, a single SIP URI entry was created that matched any DID
number assigned to an IP Office user. The entry was created with the parameters shown below:

Set Local URI, Contact, Display Name to Use Internal Data.

Set Header under Identity to P Asserted ID.

Set Send Caller ID under Forwarding and Twinning to Diversion Header.

Set Diversion Header to Auto.

Associate this line with an incoming line group by entering a line group number in the
Incoming Group field. This line group number will be used in defining incoming call
routes for this line. Similarly, associate the line to an outgoing line group using the
Outgoing Group field. The outgoing line group number is used in defining short codes
for routing outbound traffic to this line. For the compliance test, a new incoming and
outgoing group 17 was defined that only contains this line (line 17).

Set Max Sessions to the number of simultaneous SIP calls that are allowed using this SIP
URI pattern.

Default values may be used for all other parameters.

Click OK to commit (not shown).

Click OK to commit again (not shown).
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K BOOTP (6)
*+ Operator (3)
-5y §Eem 1)
[=-{F4 Line (25)

1
e D

e 20
1 202
4 207
¥ 208
-7 200
-7 210
-7 211
1212
-4 213
- 214
-7 215
4% 216
F-2 Control Unit (4)
(-4 Extension (48)
E-f  User (50)
[
i

-

J--. Group (1)

i #% Short Code (69)

o Service (0)

(- RAS (1)

EJ--@ Incoming Call Route (3)
48 WAN Port (0)

@ Directory (0)

7% Time Profile (0)

(- Firewall Profile (1)

[stP Line| Transport] SIP URI[volp [ T38 Fax|SIP Credentials| sIP Advanced|Enginering

URI Groups Local URI  Contact Display Mame Identity Header Originator Number Send CallerID Diversion Header Credential Max Calls
Il 17 17 <Internal> <Internal> <Internal> Neone  PAI Diversi

Auto 0: <Non...

Edit URL

Local URI Use Internal Data -

Contact Use Internal Data -

Display Name Use Internal Data -

Identity

Identity None -

Header P Asserted ID =

Forwarding And Twinning

Originator
Number

Send Caller ID Diversion . -

Diversion Header Auto -

Registration 0: <None> -

Incoming Group 17 -

Outgoing Group 17 -

Max Sessions 10 E

HG; Reviewed:
SPOC 4/10/2018

Solution & Interoperability Test Lab Application Notes 23 of 40
©2018 Avaya Inc. All Rights Reserved. FrontierlPO101



5.3.5. SIP Line - VoIP Tab

Select the VoI P tab, to set the VVoice over Internet Protocol parameters of the SIP Line. Set or
verify the parameters as shown below:

e The Codec Selection was configured using the Custom option, allowing an explicit
order of codecs to be specified for the SIP Line. The buttons allow setting the specific
order of preference for the codecs to be used on the SIP Line, as shown. Frontier
Communications supports codec G.711ULAW and G.729(a) for audio, with
G.711ULAW being the preferred codec.

e Select T38 Fallback for Fax Transport Support. With this setting IP Office will
attempt to use T.38 for fax first, if unsuccessful G.711 pass-through is used. Refer to
Section 2.2.

e Set the DTMF Support field to RFC2833. This directs Avaya IP Office to send DTMF
tones using RTP events messages as defined in RFC2833.

e Check the Re-invite Supported box.
e Check the PRACK/100rel Supported box.
e Default values may be used for all other parameters.
e Click the OK to commit (not shown).
IP Offices |E SIP Line - Line 17
a BOOTP (6 ‘SIP LinelTransportlSIP URIl VoIP |T38 Fa)(lSIP Credentials | SIP Advanced|Engineering
4% Operator (3
: :.J VolP Silence Suppression
}‘) [7] Local Hold Music
: % |Codec Selection [CUStD"” | ']
_ Unused Selected
\q G711 ALAW 64K o G711 ULAW 3K [C] Codec Lockdown
"y 19 G.722 64K G.729(a) 8K C5-ACELP [C] Allow Direct Media Path
% 20 6.723.1 6K3 MP-MLQ Force direct media with phones
: i | PRACK/100rel Supported
?, o - [ G711 Fax ECAN
1 202
T4 203
7 204
7 205 >>>
T:‘. 206
g-:; gg; Fax Transport Support ITBS Fallback v]
E: ;23 DTMF Support [RFcasa -]
a1 Media Security [Disabled v]

47 212

Note: The codec selections defined under this section (SIP Line — VoIP tab) are the codecs
selected for the SIP Line (Trunk). The codec selections defined under Section 5.2.3 (System —
VoIP tab) are the codecs selected for the IP phones/extension (H.323 and SIP).
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5.3.6. SIP Line — T38 Fax Tab
Select the T38 Fax tab, to set the Fax over Internet Protocol parameters of the SIP Line. Set or
verify the parameters as shown below:

e Uncheck the Use Default VValues at the bottom of the screen.

e Setthe T.38 Fax Version to 0.

e Default values may be used for all other parameters.

e Click the OK to commit (not shown).

IP Offices 7 SIP Line - Line 17
"'a BOOTP (6) |SIP LinelTransportlSIP URIlVoIP IT38 FEXlSIP CredentialslSIP AdvancedlEngineering|
E-4% Operator (3)
=432 [IP500V2 Main T38 Fax Version IU "]
[H--%57 Systern (1) Scan Line Fix-up
E--F4[Line (25) Transport UDPTL TFOP Enhancement
) Redundancy
o [] Disable T30 ECM
Low Speed o
P [] Disable EFlags For First DIS
] 0 =
High Speed z [C] Disable T30 MR Compression
""" Ny, 21 TCF Method [Trans TCF 'l [7] NSF Override
..... " . 22
..... . 23 Max Bit Rate (bps) (14400 - =
..... TT(I 201 =
..... 17 202 EFlag Start Timer (ms) 2600 = 0
----- 7 203 . 5300 -
..... £ 208 EFlag Stop Timer (ms) >
""" T_I' 205 Tx Metwork Timeout (sec) 130 =
----- T4 206
..... TT(I 20?
..... 17 208 ||:| Use Default Values
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5.3.7. SIP Line — SIP Advanced Tab

Select the SIP Advanced tab. Set or verify the parameters as shown below:
e Under Call Routing Method select To Header from the pull-down menu.
e Check the box for Use PAI for Privacy.
e Default values may be used for all other parameters.
e Click OK to commit (not shown).

IP Offices i= SIP Line - Line 17
- R BOOTP () |SIP LmelTransportlSIP URIlVoIP |T38 Fa)(lSIP Credentlalsl SIP Advanced |Engmeermg|
Operator (3)
IP500V2 Main| Addressing Media
Syste
_,_i IIE)?US;IEZ Main Association Method By Source IP address v] Allow Empty INVITE a
2-JF7 Line (25 Call R Method [zﬁr e Send Empty re-INVITE a
it etl A
g ] o Mouting ° o Hieader i Allow To Tag Change [
e ]
Suppress DNS SRV Lookups | P-Early-Media Support None
e 18 Send SilenceSupp=0ff [
g 19 Identity
-y, 20 . .
-y, 71 Use "phone-context O Media Connection Disabled
iy, 22 Add user=phone | Preservation
-y 23 Use + for International | Indicate HOLD 0
$£ ;gé Use PAI for Privacy |
T_-,: 202 Use Domain for PAI ] Call Control
1204 Swap Fi d PAL/Diversi - ] S
}r 205 wap From and PAUDiversion O Call Initiation Timeout () 4 -
% 206 Caller ID from From header |
T‘; 207 Send From In Clear [ Call Queuing Timeout (mins) |3 =
%rl 208 Cache Auth Credentials Service Busy Response 486 - Busy Here
¥ 200
% 210 User-Agent and Server Headers on Mo User Responding Send  |408-Request Timeout
15 211 -
Ta:' 212 send Location Info [Naver Action on CAC Location Limit | Allow Voicemail
1 213 Add UUT header = 5 850 R
17 214 Add UUT header to redirected e Q830 Reason 0
1215 calls
1 206 Emulate NOTIFY for REFER [
[#-<2r Contral Unit {4) Mo REFER if using Diversion [
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5.3.8. SIP Line — SIP Engineering Tab

A SIP Line Custom String (SLIC) is required for proper operation of T.38 fax calls (refer to
Section 2.2). With this entry, IP Office will reverse the order of the media line entries in the SDP
in the re-INVITE message it sends, with the active T.38 media line entry listed first followed by
the inactive media line entry for audio (port set to 0).

To configure a custom string, select the Engineering tab and click Add. The New Custom String
section will appear. In the Custom String field, enter SLIC_PREFER_ACTIVE_SDP. Click
OK.

IP Offices |Ei SIP Line - Line 17*

- & BOOTP (6) ISIP Line| TransportSiP URI| Vol [T28 Fax|SiP Credentials|SIP Advanced| Engineering |

(4% Operator (3)
-5 IP500V2 Main Custom Strings Add...

- Systemn (1)
-7 Line (25) Remove

|

Edit...

..... " y 18
-2 Control Unit (4)
[ Extension (48) New Custom String
-§  User (50)
[
[

]u Group (1) Custom String SLIC_PREFER_ACTIVE_SDP

H- @M Short Code (69) Cancel
----- @ Service (0)
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5.4. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP
line defined in Section 5.3. To configure these settings, first navigate to User - Name in the
Navigation Pane where Name is the name of the user to be modified. In the example below, the
name of the user is H323 ext 1502. Select the SIP tab in the Details Pane. The values entered for
the SIP Name allow matching of the SIP URI for incoming calls without having to enter this
number as an explicit SIP URI for the SIP line (Section 5.3.4). The SIP Name and Contact are
set to one of the DID numbers assigned to the enterprise by Frontier Communications. The SIP
Display Name (Alias) parameter can optionally be configured with a descriptive name. If all
calls involving this user and a SIP Line should be considered private, then the Anonymous box
may be checked to withhold the user’s information from the network. This can also be
accomplished by activating Withhold Number on H.323 Deskphones. Click the OK to commit
(not shown).

IP Offices ‘ = H323 ext 1502: 1502
o4 i | Voice Recording | Button Programming | Menu Programming | Mability | Group Membership | Announcements | SIP

g RemoteManager

- NoUser SIP Name 5851239827

----- § 1101 Btnl101dcp

----- § 1102Bdn1102dep ||| SIP Display Name (Alias) H323 et 1502

----- § 1103 Ban1103dcp

----- § 1104 Bxtn1104 Contact 5851239827

----- £ 1105 Extn1103
----- § 1106 Extn1106
----- § 1107 Bxtm1107 [C] Anonymous
----- £ 1108 Extn1108

----- § 1603 Extn1603

----- §+1502 H323 ext 1502
----- § 1542 H323 ext 1542
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5.5. Outbound Call Routing

For outbound call routing, a combination of system short codes and Automatic Route Selection
(ARS) entries are used. With ARS, features like time-based routing criteria and alternate routing
can be specified so that a call can re-route automatically if the primary route or outgoing line
group is not available. While detailed coverage of ARS is beyond the scope of these Application
Notes, and alternate routing was not used in the reference configuration, this section includes
some basic screen illustrations of the ARS settings used during the compliance testing.

5.5.1. Short Codes and Automatic Route Selection

To create a short code to be used for ARS, right-click on Short Code, the Navigation pane and
select New. The screen below shows the short code 9N created (note that the semi-colon is not
used here). In this case, when the IP Office user dials 9 plus any number N, instead of being
directed to a specific Line Group ID, the call is directed to Line Group 50: Main, which is
configurable via ARS.
e Inthe Code field, enter the dial string which will trigger this short code. In this case, 9N
was used (note that the semi-colon is not used here).
e Set Feature to Dial. This is the action that the short code will perform.
e Set Telephone Number to N. The value N represents the number dialed by the user after
removing the 9 prefix. This value is passed to ARS.
e Setthe Line Group ID to 50: Main to be directed to Line Group 50: Main, this is
configurable via ARS.
e For Locale United States (US English) was used.
e Click the OK to commit (not shown).

IP Offices = 9N: Dial
----- L L = || Short Code
----- PX 46
..... o +47 Code aM
----- P *43
..... X 49 Feature Dial
----- 2X *50
..... @ *51 Telephone Mumber M
..... Px 52 . - Mai
_____ O 53NE Line Group ID 30: Main
""" @55 Locale United States (US English)
----- BX *57*NE
..... BX B0 Force Account Code
""" Px *ﬁl*N’_{ Force Authorization Code
----- BX *T0* N2
..... “ EN
-
----- 83 _FNEOD
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The following screen shows the example ARS configuration for the route Main. Note the
sequence of X’s used in the Code column of the entries to specify the exact number of digits to
be expected, following the access code and the first set of digits on the string. This type of setting
results in a much quicker response in the delivery of the call by IP Office.

To create a short code to be used for ARS, select ARS - 50: Main on the Navigation Pane and
click Add.

e Inthe Code field, enter the dial string which will trigger this short code. In this case, 1
followed by 10 X’s to represent the exact number of digits.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to 1N. The value N represents the additional number of digits
dialed by the user after dialing 1 (The 9 will be stripped off).

e Setthe Line Group Id to the Line Group number being used for the SIP Line, in this
case Line Group ID 17 was used.

e Click OK to commit.

Edit Short Code

Code TXROCOO00K
Feature Dial -

Telephone Number 1N

Line Group 1D 17 -

Locale | United States (US Engish) v

Force Account Code [

Force Authorization Code [

Repeat the above procedure for additional dial patterns to be used by the enterprise to dial out
from IP Office.
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The first example highlighted below shows that for calls in the North American numbering plan,
the user dialed 9, followed by 1 and 10 digits (represented by 10 X’s). The 9 is stripped off, the

remaining digits, including the 1 shown in the examples below, are included in the SIP INVITE
message IP Office sends to Frontier Communications.

IP Offices | EZ Main ek - 1
=& BOOTP (6) ARS
{# Operator (3)
=] "“J ARS Route ID 50 Secondary Dial tone
528 System (1)
T L
T . Elg:tEi?)Unit @ Route Name Main ISystemTone A
-4 Extension (48]
ﬂ User (50) Dial Delay Time [Systam Default (4) = Check User Call Barring
2% Group (1)
BX Short Code (69)
N @ Service (0) Description
oy RAS (1)
e Incoming Call Route (3)
49 WAN Port (0) In Service Out of Service Route [<None> -
-2 Directory (0)
1 Time Profile (0) 1
@) Firewall Profile (1) Time Profile <None> ——f (Ut of Hours Route [(None) v]
-l IP Route (7)
-~ Account Code (0) l
R License (90)
h : Lt’e‘l?l:ll(ﬁis @ Code Telephone Number F?ature Line Group ID = Add
= | LHCOCOOCRK 1N Dial 17 |
s 2000000 2N Dial ¥ __| [ Remove
ST Outbound Fax an an Dial 17 E cait
- Location (0) 611 611 Dial 17 -
ﬂ Authaorization Code (0) EX0000X BN D::I 17
BLIGCOCO0 81N Dial 22
I911 911 Dial Emeraency 17 o
€ r
..... 3 l
----- T 30 | ey Allternate Route <None> ']
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5.6. Incoming Call Route

An incoming call route maps inbound DID numbers on a specific line to internal extensions, hunt
groups, short codes, etc., within the IP Office system.

In a scenario like the one used for the compliance test, only one incoming route is needed, which
allows any incoming number arriving on the SIP trunk to reach any predefined extension in IP
Office. The routing decision for the call is based on the parameters previously configured for
Call Routing Method and SIP URI (Section 5.3.4) and the users SIP Name and Contact,
already populated with the assigned Frontier Communications DID numbers (Section 5.4).

5.6.1. Incoming Call Route — Standard Tab

On the Standard tab of the Details pane, enter the parameters as shown below:
e Set Bearer Capacity to Any Voice.
e Set the Line Group ID to the incoming line group of the SIP Line defined in Section 5.3, in
this case 17 was used.
e Default values can be used for all other fields.

Ll

IP Offices = 17
1R BOOTP (5) Standard | Voice Recording | Destinations |
-4 Operator (3
=)-={ IP500V2 Main
+)-%53 System (1) Bearer Capabili Any Voice T
-7 Line (26) penity I -
1] Control Unit (4) Line Group ID 17 -
+¢ Extension (48)
+i User (50) Incoming Mumber
- Group (1)
-9 Short Code (69) Incoming Sub Address
B Service (D) :
+“% RAS (1) Incoming CLI
% Inceming Call Route (3] Locale I v]
- Priority Il - Low v]
I U
----- EB WAN Port (0) Tag
----- @ Directory (0]
..... 7 Time Profile (0) Held Music Source IS],rstem Source VI
+-414} Firewall Profile
+g 1P Route (7) S Ring Tone Override Mone -
----- B Account Code (0)
----- 8 License (90)
----- % Tunnel (0)
#-§5 User Rights (8)
- ARS (2)
-8 Location (0]
-4 Authorization Cede (0)
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5.6.2. Incoming Call Route — Destinations Tab

Under the Destinations tab, enter “.” for the Default VValue. This setting will allow the call to be
routed to any destination with a value on its SIP Name field, entered on the SIP tab of the User,
which matches the number present on the user part of the “To” header on the incoming INVITE

message received from Frontier Communications. Click OK to commit (not shown).

IP Offices

| F

17

=& BOOTP (3)

T
i+ Control Unit (4)
a4 Extension (48)
w-§  User (50)

-3 Group (1)
&8 Short Code (69
@ Service (0)

-l RAS
—e Incoming Call Route (3)
P
-0

L™
-4} WAN Port (0

@ Directory (0)

-1 Tirme Profile (0)

+@ Firewall Profile (1)
-l 1P Route (7)

-l Account Code (D)
B License (90)

-l Tunnel (0)

3 ﬁ 3 User Rights (8)

- ARS (2)

E Location (0)

ﬂ Authorization Code (0)

| Standard |Voir_e Recording | Destinations

4

TirmeProfile Destination

Fallback Extension

Default Value

|v||
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5.7. Save Configuration

Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.

The following will appear, with either Merge or Immediate selected, based on the nature of the
configuration changes made since the last save. Note that clicking OK may cause a service
disruption. Click OK to proceed.
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Save Configuration

IP Office Settings
IP500V2 Main

Configuration Reboot Mode
Merge

@ Immediate
When Free
Tirmed

Reboot Time

11:31

Call Barring

fol® &)

Help
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6. Frontier Communications SIP Trunking Service
Configuration

To use Frontier Communications SIP Trunking Service, a customer must request the service
from Frontier Communications using the established sales processes. The process can be started
by contacting Frontier Communications via the corporate web site at:
https://frontier.com/enterprise and requesting information.

During the signup process, Frontier Communications and the customer will discuss details about
the preferred method to be used to connect the customer’s enterprise network to Frontier
Communications network.

Frontier Communications is responsible for the configuration of Frontier Communications SIP
Trunking Service. The customer will need to provide the public IP address used to reach the IP
Office at the enterprise. In the case of the compliance test, this is the public IP address of the IP
Office WAN port (LAN2).

Frontier Communications will provide the customer the necessary information to configure
Avaya IP Office following the steps discussed in the previous sections, including:

e SIP Proxy IP address.

e DID numbers, etc.
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7. Verification Steps

This section provides verification steps that may be performed to verify that the solution is
configured properly.

The following steps may be used to verify the configuration:
o Verify that endpoints at the enterprise site can place calls to the PSTN.
e Verify that endpoints at the enterprise site can receive calls from the PSTN.
e Verify that users at the PSTN can end active calls to endpoints at the enterprise by
hanging up.
o Verify that endpoints at the enterprise can end active calls to PSTN users by hanging up.

7.1. IP Office System Status
The following steps can also be used to verify the configuration.

Use the IP Office System Status application to verify the state of SIP connections. Launch the

application from Start - Programs - IP Office - System Status on the PC where IP Office
Manager is installed, log in with the proper credentials.

AVAYA IP Office System Status

Help Exit  About

Online | Sfffine

Logon

Control Unit IP Address: BB in

Services Base TCP Port: [HskhE!

e B [ Automatic

M B R Adninistrator
Password:

M Auto reconnect

ﬂ Secure connection
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Select the SIP line under Trunks from the left pane. On the Status tab in the right pane, verify
the Current State is Idle for each channel.

AVAYA

System

& Alarms (14)
Extensions (26)
Trunks (9)

Line: 1

Line: 2

4

Line: 18

Line: 19

Line:

Line:

Line:

Line:
Active Calls
Resources
Yoicemail
IP Hetworking
Locations
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" status | LEi

Line Service State;
Peer Domain Mame:
Resolved Address:
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Mumber of Channels in Lise:
Administered Compression:
Enable Faststart:

Silence Suppression:

Media Stream:

Layer 4 Protocal:

SIP Trunk Channel Licenses:

SIP Device Features:

Mumber of Administered Channels:

SIP Trunk Channel Licenses in Use:

IP Office System Status

In Service
sipiff 24,40
24,40

17

10

i}

G711 Mu, G729 4
OFf

on

RTF

LDp

128
®-
u]

UPDATE {Incoming and Oukgaing)

SIP Trunk Summary

Round Trip
1 Idle 05:50:56
2 Idle 05:50:56
3 Idle 5 days 04:..,
4 Idle 5 days 04:..,
5 Idle 5 days 04:..,
=] Idle S days 04:...
7 Idle 5 days 04:..,
g Idle Sdays 04:...
9 Idle 5 days 04:..,
10 Idle S days 04: ...
Trace Trace Al Pause | Fing | &l Details Graceful Shutdown Force Out of Service Print... Save As..,
Solution & Interoperability Test Lab Application Notes 37 of 40
©2018 Avaya Inc. All Rights Reserved. FrontierlPO101




7.2. Monitor

The Avaya IP Office Monitor application can be used to monitor and troubleshoot signaling
messaging on the SIP trunk. Launch the application from Start - Programs - IP Office >
Monitor on the PC where IP Office Manager was installed. Click the Select Unit icon on the
taskbar and Select the IP address of the IP Office system under verification.

Iﬂ_ Avaya IP Office Sys™Monitor - [STOPPED]
File Edit Wiew Fikers Status Help

=& »8T| x|V @ ==

' RN

Start/Stop Trace Select
Trace Options  Unit

Clicking the Trace Options icon on the taskbar, selecting the SIP tab allows modifying the
threshold used for capturing events, types of packets to be captured, filters, etc. Additionally, the
color used to represent the packets in the trace can be customized by right clicking on the type of
packet and selecting the desired color.

All Settings =3
T1 | woomp | wPN | weN | soN | ssl | Jade |
aTM | Cal | DTE | ECont | FrameRelaw | GOD | H323 | Interface |
15SDM | Few/Lamp | Directon | Media | PFP | R2 | Routing | Services SIF |S_l,lstem|
Ewvents
¥ Sip [Vobose - I STUM [~ SIP Dect
Packetz
[~ SIP Reg/Opt R= [~ SIP Misc B=
[~ SIP Reg/Opt Tx [ SIP Misc Tx
[ SIPCallRx [~ Crn Motifp R«
[~ SIPCallTx [~ Crn Motify T=
I+ Sip Rx I hex IP Filter [nan.nnn.nnn. nnn)
¥ Sip Tx ™ hex |
Default AII| Clear All | Tab C|eam||| Tab sBmu| 86 ]| cancel
Save | Load File | Load Partial File| Select File |
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8. Conclusion

These Application Notes describe the configuration necessary to connect Avaya IP Office
Release 10.1 to Frontier Communications SIP Trunking Services. Frontier Communications SIP
Trunking Services is a SIP-based Voice over IP solution for customers ranging from small
businesses to large enterprises. It provides a flexible, cost-saving alternative to traditional
hardwired telephony trunks.

Interoperability testing was completed successfully with the observations/limitations outlined in
the scope of testing in Section 2.1 as well as under test results in Section 2.2.

9. Additional References

This section references the documentation relevant to these Application Notes. Product
documentation for Avaya IP Office, including the following, is available at:
http://support.avaya.com/

[1] Avaya IP Office Platform Solution Description, Release 10.1, Issue 1.2, September 2017.

[2] Avaya IP Office Platform Feature Description, Release 10.1, Issue 1a, September 2017.

[3] Deploying Avaya IP Office Platform IP500 V2, Document Number 15-601042, Issue 32m,
January 22, 2017.

[4] Administering Avaya IP Office Platform with Manager, Release 10.1, Issue 14, July 2017

[5] Using Avaya Communicator for Windows on IP Office, Release 10, August 2016.

[6] Administering Avaya Communicator on IP Office, Release 10.0, Issue 01.01, August 2016.

[7] Avaya IP Office Platform Security Guidelines, Release 10. Issue Ole, May 8, 2017.

[8] IP Office Technical Bulletin number 175
(http://www.ipofficeinfo.com/TechBulletins/tb175.pdf)

Additional Avaya IP Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/
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Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya
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